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1 Introduction 

1.1 Target Audience 

This guide is intended to provide guidelines for global Finastra UI (User Interface) team members for 
standardizing, clarifying, and simplifying the creation of user facing application elements. These 
guidelines enable UI content professionals to ensure consistency, clarity, and accuracy in the creation 

of this content. 

2 Writing Guidelines 

2.1 Language and Spelling 

Use American (U.S.) English in all documentation. This language is the form of English used in the 

United States and includes all English dialects used within the United States. 

Perform a spell check on text prior to submitting it, using English (U.S.) spelling. From Word, define 

and run the spell checker in English (United States). 

2.2 Bias Free Communication 

Finastra applications need to depict diverse individuals from various walks of life, and for that reason, 
do not use terms that show bias with regard to: gender, race, culture, ability, age, sexual orientation, 

disability, or socioeconomic status. 

Use only gender-neutral terms to refer to human beings, instead of specific masculine or feminine 

terms. 

Use plural nouns and plural pronouns. Avoid problems with using singular nouns and pronouns by 

using plural ones: 

 No: To log in, the user must enter his login name and password. 

 Yes: To log in, enter your login name and password. 

 Yes: To log in, users must enter their login names and passwords. 

 

2.3 Style 

Good writing style is synonymous with strong communication. A few basic stylistic considerations 

include simplicity, directness, and accuracy, which helps improve communication in our applications.  

These considerations also add to usability and are easier and less costly to translate.  

When writing technical documentation of any type: 

 Use active voice. See Voice and Tone. 

 Empower the reader by using language that informs and encourages them. 

 Respect the reader’s level of technical knowledge and competency. 

 Use short, plain words whenever possible and avoid jargon and slang. 

 Omit unnecessary words. 

 Write clear, easily understood sentences that are useful to the user. 

 Write in an appropriate way that suits the situation. Adapt your tone depending on what you are 
writing about. See Voice and Tone. 
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 If relevant, use bulleted lists or tables to present related information. 

Readers project some significance onto every change in tone, language, or typographic convention. A 
consistent style enables readers to internalize the language and text conventions of an application. As 

a result, understanding occurs more easily and significant points stand out more clearly.  

2.4 Grammar 

This section focuses on grammatical style issues that must be taken into account when writing UI 

documentation content. 

2.4.1 Person 

In general, address the user or reader as “you.” 

Second person, or direct address, use the personal pronoun “you,” which helps avoid a passive voice 
because it focuses the discussion on the user.  

2.4.2 Tense 

Use simple present tense to help readers scan material quickly. Try to avoid all other tenses.  

 Tense Example 

1. Correct The Profile dialog box appears. 

Incorrect The Profile dialog box will appear. 

2. Correct When the definition of a specific profile changes, the profile displays as 
pending until changes are either approved or declined.  

Incorrect When the definition of a specific profile has been changed, the profile will be 
displayed with a pending status until the changes are either approved or 
declined. 

 

2.4.3 Sentence Length 

Use sentences of a reasonable length. Complex, compound sentences are difficult to understand, 

even in one's native language. Be specific and avoid vague language. 

Often two short sentences can clearly express an idea. If you are having trouble punctuating a long 
sentence, consider breaking it down into two shorter ones. If a sentence exceeds more than 16 words 
in length, it may be too long. Also remember to use one space between sentences and after the use 

of a comma. 

Note: Sentences are often longer in other languages than they are in English, which can impact on 
Localization. 

 

Wherever possible, state the task or purpose at the beginning of the sentence. Always remember, a 

period marks the end of a sentence. For more information see Periods. 

Example: 

To view messages, open the queue. 



 

Global Payments Solutions (GPS) | Applications' Style Guide |  Page 6 

2.4.4 Punctuation 

Writers must be consistent when adding punctuation and adhere to stringent punctuation rules. For 
example, every English sentence must end with punctuation, such as a period, or a question mark. 

Other relevant and often used punctuation marks are included below. 

Note: This includes sentences in a bulleted list. Short sentences and single words in a bulleted list are 
not required to end with punctuation. 

2.4.4.1 Periods 

A period marks the end of a sentence and goes inside quotation marks. They go outside parentheses 
when the parenthetical is part of a larger sentence, and inside parentheses when the entire sentence 

is parenthetical (i.e. stands alone). 

Example: 

 The file is uploading (this might take a few minutes). 

 (Avoid taking the above action.) 

2.4.4.2 Commas 

Use a comma after all introductory elements. Any element, regardless of the length, which is located 
before the main clause should be punctuated with a comma. (The main clause is that core part of a 

sentence that makes it a complete sentence; that is, it expresses a complete thought.)  

Example: 

 When an atom acquires enough energy to leave its orbit, the atom is positively charged. 

 Today, the computer consortium of IBM, Motorola, and Apple is announcing its new PowerPC 
chip. 

Use a comma between all independent clauses. Whenever you have a compound sentence (those 
are the ones joined by and, but, or, nor, for, whereas), put a comma before the conjunction (the words 

listed in the previous parentheses). Length of the compound sentence does not matter.  

Example: 

The tank is made of aluminum, but the outer surface is protected by a spray-on foam. 

Use a comma before the ‘and’ in a series of three or more. In a series of three or more words or 
phrases, put the comma before the ‘and’ that occurs before the final element. You may have heard 
that this series and comma rule is optional. However, there are situations where the lack of the series-
and comma can cause confusion. And when you consider that using the series and comma cannot 
hurt the meaning of the sentence, it makes sense to use it in all cases.  

Example: 

The development years involved designing the components for the Space Shuttle's engines, testing 

the original designs, and retesting the redesigned components. 

2.4.4.3 Colons 

Although the colon has other uses in writing, its most important function is to act as a signal to the 

reader that specific information is forthcoming. 

Example: 

To make a kite, you need the following items: string, paper, thin sticks, glue, and scissors. 
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2.4.4.4 Apostrophes 

Apostrophes denote possession. The rules are as follows: 

To show possession for singular words add an apostrophe and an s ('s): 

Example: 

 Earth's shadow 

 The fish's eye 

 The Moon's orbit 

 The class’s size 

 The lens’s diameter 

 

2.4.4.5 Hyphenation 

Hyphenate two or more words that precede and modify a noun as a unit to avoid confusion.  

Example: 

 top-level assembly 

 read-only memory 

Hyphenate two words that precede and modify a noun as a unit if one of the words is a past or 

present participle. 

Example: 

 copy-protected disk 

 free-moving graphics 

 

Hyphenate two words that precede and modify a noun as a unit if the two modifiers are a number or 

single letter and a noun or participle. 

Example: 

 eight-sided polygon 

 16-bit bus 

 I-beam insertion point 
 

Hyphenate compound numerals and fractions. 

Example: 

 their forty-first birthday 

 one-third of the page 

 

Use a hyphen to indicate a range or span of numbers. 
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Example: 

 It takes 20-30 days 

2.4.4.6 Slashes 

Avoid using slashes (/) where possible. If you do use a slash, do not insert a space before or after it.  

Example: 

and/or 

2.4.4.7 Question Marks 

Question marks go inside quotation marks if they are part of the quote. Like periods, they go outside 
parentheses when the text in parentheses is part of a larger sentence and inside parentheses when 

the text in parentheses stands alone. 

2.4.5 Ampersands 

Do not use ampersands unless one is used as a part of a company or brand name. 

 Ben and Dan 

 Ben & Jerry’s 

 

2.4.6 Prefixes 

In general, do not hyphenate words that begin with prefixes (such as multi or sub) unless it is 
necessary to avoid confusion, if the name of a brand or organization includes a hyphen, or, if the stem 

word is a proper noun. 

2.4.6.1 Rules for Using Hyphens with Prefixes 

 Hyphenate the word when you add a prefix before a proper noun or a numeral.  

Examples: un-American, pre-1980 

 Hyphenate the word when you add the prefix ex meaning former.  

Example: ex-president (Do not use a hyphen if ex means out of or away from, as in expel.) 

 Hyphenate after the prefix self.  

Examples: self-respect, self-assured, self-control 

 Hyphenate to separate two a’s, two i’s, or other letter combinations that might cause misreading 
or mispronunciation.  

Examples: ultra-ambitious, anti-intellectual, co-worker 

 A hyphen may be used to separate two e’s or two o’s to improve readability or prevent 
mispronunciation. 

Examples: co-opt and co-owner vs. coordinate; de-emphasize vs. reenter  

Note: many words with double e’s used to be hyphenated as a general rule, as in re-elect, re-
establish, and pre-existing. However, current style manuals and dictionaries now tend toward 
‘closing’ the word except in cases where readability is affected. Both versions are currently 

accepted and listed in most dictionaries. 

 A hyphen is sometimes used after the prefix re to prevent misreading or confusion with another 
word. 
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Examples: re-cover vs. recover, as in Re-cover the boat when you recover from the flu. re-lay vs. 

relay, as in Please relay the message that they will re-lay the tiles 

2.4.7 Acronyms 

Acronyms are acceptable for widely recognized words, but with the first instance of the word in a 
document, write out the acronym completely, followed by the acronym in parentheses, for example, 
Application Service Provider (ASP). The acronym can then be used in all references following the first 

instance of the word. 

Note: When using Finastra in a sentence, always write out the name in full. 

Do not abbreviate product names. For example, do not shorten Active View Item Processing to Active 

View IP or AVIP. For a current list of Finastra product names, see Finastra.com. 

2.4.8 Plurals 

Form the plural of an acronym or a number by adding an ‘s’ with no apostrophe. 

Example: 

 APIs 

 CPUs 

 486s 

Additional Examples: 

 To add rows or columns to a table… 

 To add one or more rows to a table… 

Avoid: To add a row(s) or column(s) to a table… 

2.4.9 Percentages 

Do not use the % symbol. Spell out the word ‘percent.’ 

Example: 

 50 percent 

2.4.10 File Extensions 

When referring to a file extension type, use uppercase without a period. Add a lowercase ‘s’ to make 

the extension type plural. 

 GIF 

 PDF 

 HTML 

 JPGs (plural) 

2.4.11 URLs and Websites 

Capitalize the names of websites and web publications. Do not italicize. 

Example: 

 Time Magazine 

 The BBC 

http://www.finastra.com/
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Avoid spelling out URLs, and if possible do not include: http://www, but rather use the name of the 

URL with the relevant link. 

2.5 Capitalization 

Only capitalize when absolutely necessary. The majority of the application text will be capitalized 
using Sentence Capitalization. It is easier and more natural to read, and therefore is more adequate 
for most controls: labels, fields, lists, group box (frame) headers, radio buttons, dropdown lists, 

checkboxes etc. 

To achieve a consistent sentence capitalization, make sure you capitalize the first letter of the first 
word, and any other words normally capitalized in sentences, such as names, brand names etc. e.g. 

Are you sure you want to quit Global PAYplus? 

Use these guidelines for consistent capitalization: 

 Capitalize field names and data grid titles, as they appear in the User Interface, such as Column, 
User ID, or Continue. 

 Capitalize button action words, such as Submit, Next, or Continue. See Buttons. 

 Capitalize the first word for option buttons and sentence case for button field items. See Option 
Buttons. 

 Capitalize the first word for checkbox items and sentence case for checkbox items. See 
Checkboxes. 

 Capitalize the first word for dropdown list names and sentence case for menu items. See 
Dropdown Lists. 

 Capitalize navigation titles for main or global navigation. 

 Capitalize all acronyms, e.g. MOP, BIC, SDD, USD etc. 

 Capitalize Finastra product names exactly as they are branded. For a current list of Finastra 
product names, see Finastra.com 

 Use a standard 3-number World Bank Code as a country acronym. For example, forUnited 
States, use USA, or for Mexico, use MEX. For a current list of World Bank Codes by country, see 
http://www.irows.ucr.edu/research/tsmstudy/wbcountrycodes.htm. 

 Capitalize names of Countries, U.S. states, such as Arizona, Canadian provinces, such as 
Saskatchewan, or other territories or country divisions as needed. 

 Capitalize the first word of every letter in Error! Reference source not found., except articles, c

oordinating conjunctions, and prepositions of three letters or fewer. However, any word that is the 
first word in the headline or the last word should be capitalized. 

 Capitalize all Group titles. Never capitalize an entire sentence. Many people find it difficult to read 
blocks of upper case text as it loses the shape of the words. Also IT COMES ACROSS AS IF 
BEING SHOUTED AT! 

 Use Military time to avoid confusion between a.m. and p.m. hours. Military time operates on a 24- 
hour clock that begins at midnight which is referred to as 0000 hours, with 1:00 a.m. being 0100 
hours, 2:00 a.m. being 0200 hours, etc. all the way to 11:00 p.m. being 2300 hours. The most 
notable difference between regular and military time is the manner in which hours are expressed., 
to indicate time of day. 

 Capitalize the word ‘Bank’ in bank names that include the word ‘Bank’, such as Roza Bank or 
Deutsche Bank. 

 Do not capitalize random words in the middle of sentences. Here are some words that we never 
capitalize in a sentence:  

- website 

- internet 

http://www/
http://www.finastra.com/
http://www.irows.ucr.edu/research/tsmstudy/wbcountrycodes.htm
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- online 

- email 

 Words that never get capitalized (unless they come after a colon or in the beginning/ending of a 
sentence) include: the, a, an, of, for, by, to, on, as, for, and, but, nor, or 

For more words that might be problematic see Common Word Usage. 

2.6 Writing Clean Content 

This section identifies words, phrases, constructions, and practices that often lead to abstract or 

unclear meaning, disjointed cadence, or unnatural and improper language usage. 

2.6.1 Redundancies 

Redundancies occur when the literal meanings of the words repeat unnecessary meaning to a 
phrase. This table lists some common examples of redundancies and alternatives. 

Note: If you are not sure about a term/word contact the technical writing team for guidance. 

Instead of Use 

Accidental mistake Mistake 

Add additional Add 

Add on Add 

Already exists Exists 

At this point in time At this point, OR at this time 

Basic fundamentals Fundamentals 

Boot up Boot 

Check to be sure Check, ensure, make sure 

Close proximity Close, near, nearby 

Connect together Connect 

Create a new Create 

Dial up Dial 

Edit an existing Edit 

Existing conditions Conditions 

First create Create 

Group together Group 

Necessary prerequisites Prerequisites 

Print out Print 

Specific requirements Requirements 

Start up Start 
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Instead of Use 

Still pending Pending 

Time out Time 

Whether or not Whether, if 

Appropriate  Relevant 

 

2.6.2 Roundabout Phrases 

Avoid Comments 

Remove wordy, roundabout 
expressions and phrases. 

Instead of Use 

due to the fact that because 

during the course of during 

for the most part usually 

for the purpose of for 

given the condition that if 

in an efficient manner efficiently 

in case of a in a 

in case (in the case that) if 

in conjunction with with 

in order for for 

in order to to 

in the event that if (or when) 

 

2.6.3 Repetitive Words 

Avoid Comments 

Simplify phrases and minimize 
wordiness to avoid needless 
repetition. 

Instead of Use 

by means of by 

create a new create a 

end result end (or result) 

exactly the same the same 

group together group 

refer back refer 
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Avoid Comments 

repeat again repeat 

subject matter subject 

 

2.6.4 Long Words 

Avoid Comments 

Choose direct, short words. Instead of Use 

accomplish do 

additional more 

construct, fabricate make 

enumerate, itemize list 

initiate, commence begin, start 

locate find 

majority most 

perform do 

present give, show, tell 

prior to before 

terminate end 

utilize employ – use 

via by, through 

 

2.6.5 Phrasal Verbs 

Avoid Comments 

Avoid phrasal verbs; these can 
create confusion for non-native 
speakers of English. 

Instead of Use 

speed up Accelerate 

line up Align 

fill in, fill out Complete 

put off defer (or postpone) 

cut off disconnect 

leave out exclude 

look at review 
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Avoid Comments 

bear in mind; keep in 
mind 

remember 

 

2.6.6 Ambiguous Words 

Avoid Comments 

Use one word instead of two or 
three to avoid use of ambiguous 
words.  

Instead of Use 

as because 

as long as if 

in spite of regardless, despite 

2.6.7 Contractions 

Do not use contractions, such as “can’t”, “don’t”, and “won’t”. The word “cannot”, which is one word, is 

acceptable. 

2.6.8 Writing Concisely 

This table provides more information about words, phrases, and expressions to avoid when writing 

concise technical documentation: 

Avoid Comments 

Do not include more than one 
negative word (double negative) 
in a sentence. 

Replace “not” combinations with 

one word. 

Instead of Use 

not many few 

not the same different 

not different similar 

not unlike like 

not exclude include 

not until only when 

not unless only if 

does not have lacks 

does not allow prevents 

does not accept rejects 

not able unable 

not possible impossible 

 

Note: In general use positive language rather than negative language. One way to detect negative 
language is to look for words like ‘cannot,’ “do not,” etc. 
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2.6.9 Ambiguous words 

Avoid Comments 

Use one word instead of two or 
three to avoid use of ambiguous 

words.  

Instead of Use 

as because 

as long as if 

in spite of regardless, despite 

 

2.7 Common Word Usage 

This table provides guidance about using words that are commonly used in technical documentation. 

Word Usage 

add-on, add on add-on (noun, adjective), add on (verb). 

back end, back-end back end (noun), back-end (adjective) 

biannual, biennial Biannual indicates twice a year and is a synonym for 
the word semiannual. 

Biennial indicates every two years. 

bimonthly  Bimonthly indicates every other month; Semi-monthly 
means twice a month 

checkbox One word, no hyphen 

check in vs. check-in Two words as a verb; hyphenated as a noun or 
adjective 

client vs. customer Client refers to financial institutions that use Finastra 
products and services.  

Customer refers to consumers of a financial institution. 

comprise; compose To comprise is “to be made up of, to include.”  

To compose is “to make up, to form the substance of 
something.”  

The phrases comprise of or comprises of, though 
common, is poor usage. Instead, use composed of, 
consists or consisting of, or made up of. 

coworker One word, no hyphen 

data center Two words 

date Spell out the name of the month (November 4, 2017) 

Do not use day abbreviations if you are writing the 
complete date (November 4, 2017, rather than 
November 4th, 2017). 

When a phrase lists a month and a year, do not 
separate the year with commas, for example, January 
2017 proved to be a strong Sales month.  

When a phrase refers to a month, day and year, set 
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Word Usage 

off the year with commas, for example, He told the 
R&D team that he needed the final presentation by 
Friday, December 3. 

Daylight Saving Time (DST); Saving is singular, not plural (savings) 

Double-click Hyphenated 

Dropdown 

Drop down 

Dropdown is used when the relevant <Field Name> is 
selected from the Dropdown list. 

Drop down is the verb. 

e-commerce e-commerce (the industry), hyphenated 

email Lowercase, one word, no hyphen 

end user; end-user Two words as a noun; hyphenated as an adjective 

emoji emoji (singular and plural) 

front end, front-end front end (noun), front-end (adjective) 

geolocation Lowercase 

hyperlink One word 

Internet Uppercase 

intranet Lowercase 

ISP Internet Service Provider; spell out on first use 

login vs. log in Login is a noun. Log in is a verb form, for example, I 
log in to my computer. 

numbers Spell out single-digit numbers; use numerals for 10 
and above. 

Except for years or dollar amounts, do not start a 
sentence with a number. 

offline One word, no hyphen 

offsite One word, no hyphen 

online One word, no hyphen 

that vs. which Use that for essential clauses, important to the 
meaning of a sentence, and without commas, for 
example, I recall the day that the conference was 
cancelled. 

Use which for nonessential clauses, where the 
pronoun is less necessary, and use commas, for 
example, The team, which finished last a year ago, is 
now in first place 

time Always list the minutes for times (10:00 A.M.) 

Use periods but no spaces when referring to A.M. and 
P.M. 
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Word Usage 

Put a space between the hyphen when listing a 
timeframe (10:00 A.M. – 11:00 P.M.) 

time zones Use capitalized acronyms, for example, PST for 
Pacific Standard Time 

user name Two words 

VoIP Voice Over Internet Protocol 

Web Uppercase W when using the abbreviated form of 
World Wide Web 

web-based Hyphenated 

webpage One word, lowercase 

website One word, lowercase 

who, whom The word Who is the pronoun used to refer to human 
beings or to animals with a name. It is grammatically 
the subject (never the object) of a sentence: The 
woman who rented the room left the window open. 

Whom is used when someone is the object of a verb 
or preposition: The woman to whom the room was 
rented left the window open. 

Wi-Fi Hyphenated; Uppercase ‘W’ and capital ‘F’ 

workflow One word 

2.8 Localization 

Localization involves the use of language professionals who translate the source application’s words 
and adapt its content to the needs and norms of the target country or market. Because language 
professionals can work only with what they are given, the source content creator must adhere to the 
GPS Applications’ Style Guide directives, which will ensure that the localization process is effectively 

performed. 

2.8.1 Date formats 

 Date format in documents related to products is based on the standard U.S. format 
(MMDDYYYY). 

 Where possible, display the month in full followed by DD and then YYYY, for example, December 
02, 2018. 

2.8.2 Currency 

When writing about currency, use the currency symbol (e.g. $) before the amount. Include a decimal 
and number of the lower denomination if more than 0. Alternatively, you may use the 3 letters ISO 

currency code 

 $20 

 $19.99 

 JPY 500 

 GBP 10,000 
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Note: Although the currency symbol (e.g. $) before the amount is widely used it might differ for some 
countries. 

2.8.3 Telephone Numbers 

Write telephone numbers as per the format used in the country for which you are providing the 
telephone number for. These numbers will include a country prefix code and possibly also a county 

code.  

2.9 Content Formatting 

2.9.1 Lists 

 Lists must include at least two items. Use a list when you have a list of two or more items in which 
any of the items consists of two or more words, or, when you have a list of two or more items in 
which any of the items is a link. 

 Use secondary entries only if you cannot avoid them. Complex entries defeat the easy-to-read 
format of a list. 

 Use unnumbered (bulleted) lists when the entries are not dependent on the sequence in which 
you present them. 

Use a bulleted list to: 

 Break out information from paragraph format. 

 Structure the information into an easier-to-read format. 

Use a numbered list to: 

 In a procedure, as procedural steps 

 When the entries are dependent on sequence, use numbered lists with numerals and letters to 
build the hierarchy. 

2.9.1.1 Capitalizing and Punctuating Lists 

 Capitalize the first word of each entry in all lists, whether or not the entry forms a complete 
sentence. 

 Capitalize product names exactly as they are branded. 

 Capitalize an individual’s title only when placed before the individual’s name, for example, Vice 
President John Smith. 

 Do not use a period at the end of short items in a list. 

 Use a period at the end of each item in a list of complete sentences. 

 Avoid mixing complete sentences and sentence fragments (short items) in the same list. If you 
must have a mixed list, add periods at the end of every list item. 

 Begin each item in a bulleted list with a capital letter.  

 If a list begins with a summary word or phrase followed by an explanation: Only the first letter 
should be a capital letter unless the word is capitalized, for example, queue names. 

2.9.1.2 Writing Bulleted Lists 

 Bullets are used for lists when the order is not important (for example, a list of options in a dialog 
box).  

 If there is only one item in the list, it is not a list, and should not be included in a bullet.  

 Introduce a list with a sentence or fragment ending with a colon.  

 Begin each item in a bulleted list with a capital letter.  
Do not use a period at the end of each item for one-word or brief items.  
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Example: 

The Styles ribbon in the Home tab includes these groups: 

- Clipboard 

- Font 

- Paragraph 

- Styles 

- Editing 

 If the list items are complete sentences, use a period at the end of each item. 

 

Example: 

Perform one of the following actions: 

- Create a new file. 

- Copy a file to a different folder. 

- Quit the Microsoft Excel software. 

 If a list begins with a summary word or phrase followed by an explanation: 

- Only the first letter should be a capital letter unless the word is capitalized, for example, 
queue names. 

- Summary word or phrase is in bold. This style is often referred to as a bold lead-in. This 
structure works well when you have explanatory text for each entry.   

- Use a colon (:) after the summary word or phrase. This colon is also bold.  

 

Example: 

These options are available in Word: 

- General: General options for working with Word. 

- Display: Change how document content is displayed on the screen and when printed. 

- Proofing: Change how Word corrects and formats your text. 

2.9.1.3 Writing Numbered Lists 

Use numbered lists for multiple-step user tasks within a procedure. 

User tasks should contain no more than ten steps if possible. If a task has more than ten steps, 

consider breaking the task down into small subtasks. 

When writing a procedure: 

 Use active voice.  

 Capitalize the first word in each step. 

 Begin each step with an action or command that the user is required to perform. Do not begin a 
step by describing the result of the previous step. 

 Use complete sentences. 

 Use a period after each step.  
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Example: 

To share your printer: 

1. Click Start.  

2. Select Settings. 

3. Click Printers. 

4. In the Printers page, select the printer that you want to share. 

5. On the File menu, click Sharing. 

A step may contain more than one action, where it is logical to do so. Combining steps can reduce the 
number of steps in longer procedures. For example, if a user needs to set several options in a single 
dialog box, these may be combined into one step.  
Example: 

Sending a message with GPP involves these basic operations: 

1. Starting GPP. 

2. Creating a message. 

3. Adding text to a message. 

4. Sending the message. 

5. Closing GPP. 

 

The text for instructional steps in a numbered procedure is different from the style used for a 

numbered list. This is an example of the text of instructional steps in a numbered procedure. 

Example: 

To send a message with GPP, perform these basic operations: 

1. Start GPP. 

1. Create a message. 

2. Add text to the message. 

3. Send the message. 

4. Close GPP. 

 

This table shows examples of the correct usage of introductory words when used with procedures.  

Use Examples 

Click Click Start. 

Click the Insert tab. 

Select Select the Administrator Only checkbox. 

Select the Savings Accountoption button. 

Select the Print option from the File menu. 

Select the settings, and then click OK. 

On From the View menu, click Ruler. 

From the Insert tab, in the Links group, click Hyperlink. 

In In Control Panel, double-click Display. 
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Use Examples 

In the User Name box, enter the name of the user. 

In the Printers page, select the printer that you want to share. 

Under Under Window Options, select the Resize window to initial page 
option, and then select Document Title from the Show dropdown. 

 

2.9.2 Buttons 

Buttons must always contain actions. The language should be clear and concise. Capitalize every 

word, including articles. It’s OK to use an ampersand in button text. See Capitalization. 

Standard website buttons include: 

 Log In 

 Sign Up Free 

 Subscribe 

 Email Us 

Use enough text to explain the command button efficiently. Ideally, users shouldn’t have to read 

anything else to understand the label and functionality. 

2.9.3 Option Buttons 

 Use a label for every option button and place text immediately to the right of the option button. 

 Use natural language – write the label as a phrase, without ending punctuation. Try to keep the 
labels as clear and as brief as possible. 

 If further explanation is required, provide this information in a static text control using complete 
sentences and ending punctuations 

 Use positive phrasing and sentence-style capitalization and try to maintain roughly the same 
length for a list of option buttons. 

 Use parallel phrasing; emphasize the differences between the options by using similar text on 
labels. If all labels have the same introductory text, move that text to the group label 

 Keep all labels single-lined. If you must use multi-line labels, align the top of the label with the 
radio button. 

2.9.4 Checkboxes 

 Use a label for every checkbox and place text immediately to the right of the control. 

 Use natural language – write the label as a phrase, without ending punctuation. Try to keep the 
labels as clear and as brief as possible and make sure to use sentence-style capitalization. 

 For a group of checkboxes, try to maintain roughly the same length throughout labels 

 For a group of checkboxes, use parallel phrasing and emphasize the differences between the 
options by using similar text on labels.  

 If all labels have the same introductory text, move that text to the group label. 

2.9.4.1 Group Boxes 

 Label all group boxes using sentence style capitalization. 

 Keep the label concise, without instructions on the label. If instructions are needed, include them 
as a text field within the group box 

 Do not repeat the group box label in control labels within the group box. 
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2.9.5 Dropdown Lists 

 Use consistent dropdown control and use a label for every dropdown list. 

 Use natural language. Write the label as a phrase, without ending with punctuation. Try to keep 
labels as clear and as brief as possible 

 If further explanation is required, provide this information in a static text control using complete 
sentences and ending punctuations 

 Use sentence style capitalization. 

 Position the label either to the left of or above the dropdown list. If the label is on the left, vertically 
align the label text with the control text. If the label is on top, align the label with the left edge of 
the control. 

 Keep all labels single lined. If you must use multi line labels, align the first row of the label with the 
control text. 

2.9.6 Labeling Tabs 

This section applies to header and regular tabs. 

 Use concise tab labels, with one or two words that clearly describe the content of the tab page 

 Use nouns rather than verbs, without ending punctuation. 

 Use sentence upper case only in tab names. 

 Use specific and meaningful tab labels. Refrain from generic tab labels that can apply to any tab, 
such as General, Advanced or Settings 

 If the entire tab content is disabled, add a text label at the bottom of the tab page explaining the 
reason for the tab disabled state. 

2.10 Error Messages 

An error message alerts users of a problem that has occurred. By contrast, a warning message alerts 
users of a condition that might cause a problem in the future. 

Effective error messages inform users that a problem occurred, explain why it happened, and provide 
a solution so users can fix the problem. Users should either perform an action or change their 

behavior as the result of an error message. 

Note: Well-written, helpful error messages are crucial to a quality user experience. Poorly written error 
messages result in low product satisfaction, and are a leading cause of avoidable technical support 

costs. Unnecessary error messages break users' flow. 

Examples: 

 Cannot move Sent Items. 
The Item was already moved or deleted. 

 Cannot log on because the server is temporarily unavailable. 
Check your network connection and try again. 

 Cannot find a camera. 
Make sure the camera is turned on and connected to the computer. 

When documenting error messages, follow these guidelines to write good error messages which 

should follow the order listed: 

 A problem. States that a problem occurred. 

 A cause. Explains why the problem occurred. 

 A solution. Provides a solution so that users can fix the problem. 
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In addition, good error messages are presented in a way that is: 

 Relevant. The message presents a problem that users care about. 

 Actionable. Users should either perform an action or change their behavior as the result of the 
message. 

 User-centered. The message describes the problem in terms of target user actions or goals, not 
in terms of what the code is unhappy with. 

 Brief. The message is as short as possible, but no shorter. 

 Clear. The message uses plain language so that the target users can easily understand problem 
and solution. 

 Specific. The message describes the problem using specific language, giving specific names, 
locations, and values of the objects involved. 

 Courteous. Users shouldn't be blamed or made to feel stupid. 

 Rare. Displayed infrequently. Frequently displayed error messages are a sign of bad design 

2.11 User Alerts 

User alerts convey important information related to the state of your application, and often request 
feedback. Therefore, write short, descriptive, multiword emphasized (bold) alert titles. The less text to 

read onscreen the better.  

This text needs to provide a short, simple summary of the condition that prompted the alert. This 
should be a complete sentence, and often it is presented as a question. Use sentence-style 

capitalization and appropriate punctuation for complete sentences.  

A good alert message states clearly what caused the alert to appear and what the user can do about 

it. 

Various user alerts are described below. 

 Notifications 

 Warning Messages 

 Confirmation Messages 

 Success Messages 

2.11.1 Notifications 

A notification or general information message informs users of events that are unrelated to the current 
user activity, by briefly displaying a pop-up from an icon in the notification area. The notification could 
result from a user action or significant system event, or could offer potentially useful information from 

the application. 

The information in a notification needs to be both useful and relevant, but never critical. 

Consequently, notifications do not require immediate user action and users can freely ignore them. 

The number of times to display a notification is based on its design pattern: 

Pattern How often to notify 

Action success Once. 

Action failure Once. 

Non-critical system event Once when the event first occurs. If this results from a problem 
that users need to solve, redisplay once a day. 
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Pattern How often to notify 

Optional user task Once a day for a maximum of three times. 

FYI Once. 

 

Example: 

 Windows installed new updates. 
Your computer was restarted to finish installing updates. 

2.11.2 Warning Messages 

A warning message alerts the user of something significant or a condition that might cause a problem 

in the future. 

Examples: 

 The network cable might be unplugged. 

 This page contains both secure and nonsecure items. 
Do you want to display the nonsecure items? 
Yes / No 

2.11.3 Confirmation Messages 

A confirmation message asks if the user wants to proceed with an action. 

Example: 

 Do you want to uninstall the Setup Support Files? 
Microsoft SQL Server 2017 Tools Express Edition is dependent on these files. 
Yes / No 

2.11.4 Success Messages 

A confirmation informs the user that the action taken resulted in success. 

Example: 

 Your device is ready to use 

 Device driver software was installed successfully. 

2.12 Logs 

Logs or Log files are files that record either events that occur in an operating system, or the result of 

running specific software, or messages between different users of a communication software. 

2.12.1 Rule Log 

The Rule log is common to multiple transaction types and contains a record for each rule invoked on 
a transaction or payment related message during transaction processing. 

2.12.2 System Log 

The System log file contains events that are logged by the operating system components. These 
events are often predetermined by the operating system itself. System log files may contain 

information about device changes, device drivers, system changes, events, operations and more. 
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Example: 

Web servers maintain log files that list every request made to the server. With log file analysis tools, it 
is possible to get a good idea of where visitors are coming from, how often they return, and how they 

navigate through a site. 

2.12.3 Interface Log 

The Interface log is used for logging external interface authentication. 

3 Voice and Tone 

The Voice and Tone of our applications should enable us to have a conversation with our users, 
rather than just being tools that mechanically prompt information that lacks personality. Our voice 

makes us unique while our tone makes us sound human. 

Voice and Tone is more than the words we choose. It is the way in which we communicate our 
personality as well as provide information. Voice and Tone is the way we tell our users how we feel 
about the information we are providing, and it will also influence how users feel about our information 
too. 

3.1 Voice 

When writing text ensure you maintain the voice of someone whose spoken tone of voice is friendly 

and confident and is not mechanical and distant as if tasked with producing a formal report.  

Consider the following when writing: 

Use an active voice, and not a passive voice, when writing end user text. Active voice indicates who 

or what is performing the action of the sentence, and makes sentences simple yet meaningful.  

In a sentence with active voice, the subject directly performs the action. Example 1 in this table shows 

that the subject is ‘page’ and the action is ‘displays’: 

 Voice Example 

1. Active The page displays the new field. 

Passive The page will display the new field.  

2. Active Arrange icons in alphabetical order. 

Passive Icons can be arranged by name in alphabetical order. 

3. Active The system is reliable. 

Passive The system has proven to be reliable.  

4. Active To define the member type, first create a membership profile.  

Passive Define the member type by first creating the membership profile.  

5. Active  You must first create the membership profile to define the member 
type.  

Passive The member type is defined by first creating a membership profile 

 

Only use a passive voice to indicate if the performer of the action is either unimportant to the reader 

or unidentifiable.  
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Passive sentences typically use a form of be (was, am, are, been). Typically used in requirement and 
solution documents, this document type is usually written by Business Analysts, and indicates 
anticipated behavior of an application. Long sentences in the passive voice may indicate that your 

writing style may be too formal. 

3.1.1 Indicative Mood 

The indicative mood is used to express general information such as facts, assertions, questions or 

queries, or explanations. 

 Mood Example 

1. Correct It is important to complete this procedure before taking any other action. 

Incorrect It is important that this procedure be completed before any other action is 
taken. 

2. Correct Select the desired messages then click Group All. 

Incorrect Select the desired messages, and then you can click the Group All 
button.  

3. Correct Enter your password and click OK. 

Incorrect The first step is to type a password, and then click OK. 

 

3.2 Tone 

Use a tone that inspires confidence by communicating to users on a personal level by being accurate, 
encouraging, insightful, objective, and user focused. In addition, also strive to be light, inspiring, 

straightforward, and trustworthy. 

Tone in writing is the attitude that the writer conveys to the user, which is intended to create a positive 

response or emotion from the user. 

Consider the following when writing: 

 Use a professional business style tone that is polite and friendly.  

 Do not use humor in technical documentation. Readers may interpret a humorous attitude as 
flippant or disrespectful personally, or to their culture. 

 Avoid using a conversational tone that implies judgment about the complexity of the task. 

 Avoid words like actually, easily, simply, or just.  

 



 

Global Payments Solutions (GPS) | Applications' Style Guide |  Page 27 

3.3 Persona of the System 
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